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Introduction
This section describes the features and functions of a Zebra printer that is running the 
Virtual Device-D application. 
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7Introduction
Overview
Overview

The Virtual Device-D application enables Zebra mobile and tabletop printers to work 
with many host systems that are using Datamax®Prodigy Plus® printers. In most 
cases, no changes will be required to the host application. This feature can help 
customers to make a smooth transition to Zebra printers and save them the time and 
expense of having to rewrite their host software.

Virtual Device-D Features

The Virtual Device-D application:

• Uses existing features of Zebra printers, when available.

• Offers fonts similar to the original device. These fonts will use 120 KB or more of 
memory space.

• Supports the Bluetooth®, Serial, Ethernet, WLAN, and USB interfaces.

• Offers many outline fonts, barcodes, and specific commands and features of 
target printer models (see Supported Fonts and Barcodes on page 62).

• Provides support of Datamax®Prodigy Plus® commands (see Commands 
on page 34).
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Supported Printers

This manual describes the Virtual Device-D language for Zebra mobile and tabletop 
printers and should be used by any person who needs to support that language on 
one of the following Zebra printers:

For complete printer operation, use this manual in combination with the User Guide 
for your printer.

Configuring Network Connectivity

Your printer may be equipped with one or more of the following interfaces:

• Bluetooth—For detailed information to connect a Bluetooth device, refer to the 
Bluetooth User Guide.

• Wired print server—For detailed information, refer to the ZebraNet Wired and 
Wireless Print Servers User Guide.

• Wireless print server (a/b/g/n)—For detailed information, refer to the ZebraNet 
Wired and Wireless Print Servers User Guide.

For other connectivity options, refer to the User Guide for your printer. Copies of these 
manuals are available at http://www.zebra.com/manuals.

Printer Firmware

iMZ Series V73.19.6Z and later

QLn Series V68.19.6Z and later

ZT200 Series V72.19.6Z and later

ZT400 Series V75.19.7Z and later

ZT510 V80.20.02Z and later

ZT600 Series V80.20.02Z and later

ZD400 Series V77.19.14Z or V84.20.05Z and later

ZD500 Series V74.19.6Z and later

ZD600 Series V84.20.05Z and later

ZQ300 Series V81.20.06Z and later

ZQ500 Series V76.19.10Z and later

Note • The Virtual Device-D language is supported only on 203 dpi printers.
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Notes
• Other command languages are disabled when running Virtual Device-D. 

However, Set/Get/Do (SGD) commands and file download all operate properly 
with Virtual Device-D enabled.

• Virtual Device-D fonts can only be used with Virtual Device-D commands. They 
cannot be used with other languages.

• The Virtual Device-D mode application will not respond to CPCL, ZPL, or EPL 
commands. Instead, commands will be processed by the Virtual Device-D 
application.
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Install, Register, and
Enable Virtual Device-D
This section provides you with instructions on how to install and enable the 
Virtual Device-D application on one or more Zebra printers. 
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Acquiring the Virtual Device Application
Acquiring the Virtual Device Application

To get the Virtual Device app, perform the following from your computer:

1. Open a web browser and navigate to http://www.zebra.com/virtualdevices.

2. Locate your printer type in the list of printers, and then click Download Now.

3. Fill out the information on the Virtual Device Download Request form.

4. Click Submit.

5. Read the End User License Agreement.

6. Click Accept and Begin Download Now.

Your browser prompts you to open or save the archive containing the Virtual 
Device app.

7. Save and store the Virtual Device app archive file to your computer.

The archive file contains the following:

• The Virtual Device .NRD file to be downloaded to a Zebra printer.

• A .txt file that contains the SGD command for immediately activating the 
Virtual Device app.

8. Extract the files from the archive to your computer.
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Downloading the Virtual Device-D Application

Zebra provides two options to download the Virtual Device-D app to the printer.

• On a computer with the ZDownloader Utility

The ZDownloader Utility is the only method shown in this manual. For instructions 
on how to download and install the ZDownloader Utility, see ZDownloader Utility 
on page 77.

• On an Android device with the Zebra Printer Setup Utility for Android Devices 
(available for free on Google Play™)

For information on using the Zebra Printer Setup Utility for Android Devices and to 
download the user guide, navigate to www.zebra.com/setup.

Using ZDownloader

The ZDownloader application can update Virtual Device-D files in Zebra printers 
connected by Serial, Parallel, USB, and IP Ethernet networks.

Figure 1 • Initial ZDownloader Screen

Adding Printers to the ZDownloader List

There are two ways to add printers to the list: 

• Auto-Detect (use for USB or IP Ethernet interfaces)

• Manual add (use for Serial, Parallel, or IP Ethernet interfaces)

If your printer is connecting via the serial or parallel interfaces, or is not detected by 
using the Auto-Detect method, use the Manual Add method.
P1070987-003 Virtual Device-D User Guide 6/26/18
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Auto-Detect Printers

Use Auto-Detect for USB or IP Ethernet interfaces. 

USB printers can only be added by using Auto-Detect. The ZDownloader utility can 
support as many USB printers as your computer can support (most computers 
typically can support up to 255).

Note • Ethernet connected printers are detected by the application broadcasting a 
UDP packet out onto the network. UDP port number 4201 is used for the 
discovery process. Some networks filter out UDP packets. This means that the 
ZDownloader utility may not be able to detect all of the printers on your network. 
See your network administrator for more information. If you are not able to Auto-
Detect your network printers, follow instructions for manually adding a printer.
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To Auto-Detect printers connected via the USB or IP Ethernet interfaces, 
perform the following steps:

1. In the ZDownloader toolbar, select Printer > Auto-Detect.

OR

Right-click in the ZDownloader window and select Auto-Detect Printers.

The printers detected are added to the printer list.

Manually Add Printers

To manually add printers connected via the Serial, Parallel, or Network 
interfaces, perform the following steps:

1. In the ZDownloader toolbar, select Printer > Add….

OR

Right-click in the ZDownloader window and select Add Printer…. 

The following window appears.

2. Add a printer name and your printer model in the appropriate fields.
P1070987-003 Virtual Device-D User Guide 6/26/18



15Getting Started
Downloading the Virtual Device-D Application
Adding a Serial Printer

3. Select the serial port to which the printer is connected.

4. Click Port Settings.

The following window appears.

If you are adding a… Then…

Serial Printer Go to Adding a Serial Printer.

Parallel Printer Go to Adding a Parallel Printer on page 16.

Network Printer Go to Adding a Network Printer on page 17.
6/26/18 Virtual Device-D User Guide P1070987-003



Getting Started
Downloading the Virtual Device-D Application

16
5. Adjust the settings as necessary. The printer’s serial port settings must match the 
computer’s serial port settings. For more information about the settings, refer to 
the User Guide for your printer.

6. Click OK to save the port settings.

7. Click OK to add the printer.

Adding a Parallel Printer

8. Set Communication Type to Parallel.

The available parallel ports will be shown in the Port drop-down box.

9. Select the port to which the printer is connected. No additional configuration is 
necessary.

10. Click OK to add the printer.
P1070987-003 Virtual Device-D User Guide 6/26/18



17Getting Started
Downloading the Virtual Device-D Application
Adding a Network Printer

11. Set Communication Type to Network. 

The following window appears.

12. Enter the printer’s IP address.

13. Click OK to save the network settings.

14. Click OK to add the printer.

Modifying Printers in the List

To change printer settings for a printer in the list, perform the following steps:

1. Select the printer to modify. 
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2. In the toolbar, select Printer > Modify Printer….

OR

Right-click on the printer and select Modify Printer….

The printer settings for the selected printer are displayed.

3. Modify the settings as desired.

4. Click OK to save the settings.

Deleting Printers from the List

To delete printers from the list, perform the following steps:

1. Select one or more printers to delete. 
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2. In the toolbar, select Printer > Delete.

OR

Right-click on one of the selected printers and select Delete Printer(s). 

The printer is removed from the list.

Downloading the Virtual Device App to Selected Printers

To download the Virtual Device-D app to your printer(s), you must select the file to 
send to each printer. ZDownloader, by default, downloads files to one printer at a time. 
If you have multiple printers to update and want to speed up the process, you can 
increase the number of simultaneous downloads. 

To allow simultaneous downloads, perform the following step:

1. Click Tools > Options….

The following prompt appears.

2. Raise the number shown to allow multiple simultaneous downloads.

3. Click OK.

Note • More simultaneous downloads require more of your computer resources. 
Some computers may slow down with simultaneous downloads or as more printers 
are added for simultaneous downloading.
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To download the Virtual Device app file to one or more printers, perform the 
following steps:

1. Select the printers to which you want to download the Virtual Device-D app file. To 
select multiple printers, hold down the Ctrl or Shift key, and then click on the 
desired printers.

2. In the toolbar, select File > Select Firmware File….

OR

Right-click on one of the selected printers and select Select Firmware File….

3. Navigate to the Virtual Device app file that you acquired previously.

4. Click Open.

The file that you selected appears under Download File for the selected printers.

Printers that are present in the list but that do not have a file selected will be 
ignored when Downloading starts.
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5. Start the download process by doing one of the following:

• Select Printer > Download to Selected. 

• Select the printer(s) of interest and select the Printer and then select 
Download To Selected.

6. In the toolbar, select Printer > Download All.

OR

Right-click in the ZDownloader window and select Download All.

After downloading has begun, the progress of each printer will be shown in the 
Download Status column.

Canceling a Download in Progress

The Cancel Download toolbar button and the Printer > Cancel Download menu 
options become active when the files are downloading.

To cancel downloading to ALL printers in the list, perform the following step:

1. Click Printer > Cancel Download.

OR

Right-click in the ZDownloader window and select Cancel Download.

To cancel downloading to SPECIFIC printers in the list, perform the following step:

1. Select one or more printers with a download in progress.

2. Click Printer > Cancel Download.

OR

Right-click on a selected printer and select Cancel Download.
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Registering the Virtual Device

ZDownloader maintains a log file of all items downloaded to a Zebra printer along with 
the printer serial number. You can register your Virtual Device installation with Zebra 
Repair and Tech Support to ensure that a printer sent in for repair is returned with the 
Virtual Device installed, and when engaging Zebra Tech Support, they will have 
records of the item being loaded. To register your Virtual Device installation, you must 
send the log file created by ZDownloader to the Zebra log file management group.

ZDownloader Log File

To send the log file, complete these steps:

1. Based on your operating system, navigate to the appropriate folder:

• Microsoft® Windows® XP
C:\Program Files\Common Files\FirmwareDownloader

• Microsoft Windows 7, Windows 8, and Windows 10
C:\ProgramData\Zebra Technologies\Firmware Downloader and 
ZBI Key Manager

2. Copy the log file (DownloadLog.txt), and email to Zdownloader@zebra.com.

If you are downloading from several computers, you need to send the log file from 
each computer. If you download files to printers on one day and do not send the 
file the same day, please note this in your email so that the log file management 
group picks up the previous load detail. Otherwise, they only pick up the load data 
for the day that the log file is sent. 
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Enabling the Virtual Device

You can enable Virtual Device-D by sending a Set/Get/Do (SGD) command to the 
printer or by selecting the option through the printer’s menus.

Using an SGD Command

To enable Virtual Device-D on your printer, send the following command:

! U1 setvar "apl.enable" "apl-d" 

To disable Virtual Devices on your printer and return to normal function, send the 
following command:

! U1 setvar "apl.enable" "none"

You must restart the printer after changing the value of apl.enable. For more 
information about this SGD command, see apl.enable on page 61.

Using the User Menus

This section includes instructions for the following printers:

• QLn420 Printers on page 24

• QLn320 and QLn220 Printers on page 27

• ZT230, ZT400 Series, ZT510, ZT600 Series, ZD500 Series, and ZD600 Series 
Printers on page 30

If necessary, refer to the User Guide for your printer for additional information about 
your printer’s control panel. 
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QLn420 Printers

1. From the printer’s idle display screen, press the LEFT SOFT KEY to select the 
Home icon.

The printer displays the Home Menu.

2. Use the ARROWS to navigate to the LANGUAGE menu.

PRINTER READY

VXXXXXXX

 SETTINGS 

 LANGUAGE 
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3. Press the OK button.

The printer displays the LANGUAGE selection screen.

4. Use the LEFT or RIGHT ARROW to navigate to the VIRTUAL DEVICE selection 
screen.

LANGUAGE

▼ ENGLISH ▲

VIRTUAL DEVICE

▼ NONE ▲
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5. Use the UP or DOWN ARROW to scroll to the APL-D option.

6. Press the RIGHT SOFT KEY to select USE.

The printer restarts and uses the Virtual Device that you selected.

VIRTUAL DEVICE

▼ APL-D ▲

USE
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QLn320 and QLn220 Printers

1. From the printer’s idle display screen, press the LEFT SOFT KEY to select the 
Home icon.

The printer displays the Home Menu.

2. Use the ARROWS to navigate to the SETTINGS menu.

Zebra QLn320
FW ver: XXXXXXXXXX
Baud Rate: 115200
Battery ok
IP Addr: 10.14.205.138

Menu

Communication Back

Settings Back
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3. Press the OK button.

The printer displays the VIRTUAL DEVICE selection screen.

4. Press the RIGHT ARROW to highlight the up arrow on the display.

5. With the up arrow highlighted, press the OK button until you scroll to the APL-D 
option.

Virtual Dev: none ▲ ▼

Menu Use Back

Virtual Dev: apl‐d ▲? ▼

Menu Use Back
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6. Press the LEFT ARROW to highlight APL-D

7. Press OK to select USE.

The printer restarts and uses the Virtual Device that you selected.
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ZT230, ZT400 Series, ZT510, ZT600 Series, ZD500 Series, and ZD600 Series 
Printers

1. From the printer’s idle display screen, press the LEFT SELECT KEY to select the 
Home icon.

The printer displays the Home Menu.

Note • The ZT230 control panel is shown in this procedure. The control panel for the 
other printers is similar.

PRINTER READY

VXXXXXXX

HOME MENU

SETTINGS
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2. Use the ARROWS to navigate to the LANGUAGE menu.

3. Press the OK button.

The printer displays the LANGUAGE selection screen.

HOME MENU

SETTINGS

▼
LANGUAGE

ENGLISH ▲
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4. Use the LEFT or RIGHT ARROW to navigate to the VIRTUAL DEVICE selection 
screen.

5. Use the UP or DOWN ARROW to scroll to the APL-D option.

▼
VIRTUAL DEVICE

NONE ▲

▼
VIRTUAL DEVICE

APL-D ▲

USE
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6. Press the RIGHT SOFT KEY or OK to select USE.

The printer restarts and uses the Virtual Device that you selected.

▼
VIRTUAL DEVICE

APL-D ▲

USE
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Commands
This section provides a detailed listing of commands for use on your Zebra printer 
with the Virtual Device-D app.
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Command Function Supported

Immediate Commands

<SOH># on page 39 Reset the Printer ✓
<SOH>A on page 39 Send ASCII Status String ✓
<SOH>B on page 39 Toggle Pause ✓
<SOH>C on page 40 Stop/Cancel ✓
<SOH>D on page 40 SOH (Immediate Command) Shutdown ✓
<SOH>E on page 40 Send Batch Quantity ✓
<SOH>F on page 40 Send Status Byte ✓

System-Level Commands

<STX>A on page 42 Set Time and Date ✓
Use this command to set the 
printer’s time and 
date.<STX>a on page 42

Enable Feedback Characters ✓

1F = after a batch of labels is 
completed<STX>B 
on page 42

Get Printer Time and Date Information ✓

<STX> b Set Cutter Signal Time. —

<STX>C on page 43 Copy Module ✓
<STX>c on page 43 Set Continuous Paper Length ✓
<STX>D Memory Dump (Test Mode Only) —

<STX>d Set Printer to Double Buffer Mode —

Use this command to cause 
the printer to operate in 
continuous mode with the 
specified label 
length.<STX>E on page 43

Set Print Quantity for Stored Label Format ✓

<STX>e on page 43 Select Transmissive (Edge) Sensor ✓
<STX>F on page 44 Form Feed ✓
<STX>f on page 44 Set Form Stop Position (Backfeed Command) ✓
<STX>G on page 44 Print Last Label Format ✓
<STX>g Internal Batch Software Mode —

<STX>H Set Cutter Signal Time —

Purpose on page 44 Input Image Data ✓
<STX>i Downloading Scalable Fonts —

<STX>J Request Memory Module Status OR Set Pause for 
Each Label

—
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<STX>K on page 45 Offset Distance, Top-of-Form ✓
<STX>k on page 45 Test RS-232 Port ✓
<STX>L on page 45 Enter Label-Formatting Command Mode ✓
<STX>M on page 45 Set Maximum Label Length ✓
<STX>m on page 46 Set Printer to Metric ✓
<STX>N Enter Internal Batch Mode —

<STX>n on page 46 Set Printer To Inches ✓
Use this command to tell the 
printer to receive 
measurements in inches. 
<STX>O on page 46

Set Start Print Position ✓

<STX>o on page 46 Cycle Cutter ✓
<STX>P on page 46 Character (HEX) Dump Mode ✓
<STX>p on page 47 Controlled Pause ✓
<STX>Q on page 47 Clear All Modules ✓
<STX>q on page 47 Clear Module ✓
<STX>R Ribbon Saver On/Off —

<STX>r on page 47 Select Reflective Sensor ✓
<STX>S on page 48 Set Feed Rate ✓
<STX>STEST Test Module Memory —

<STX>s Set Printer to Single Buffer Mode —

<STX>T on page 48 Printhead Dot Pattern Test Label ✓
<STX>t on page 48 Test RAM Memory Module ✓
<STX>U on page 48 Label Format Field Replacement ✓
<STX>V on page 49 Software Switch Settings ✓
<STX>v on page 49 Printer's Firmware Version Information ✓
<STX>W on page 49 Request Memory Module Information ✓
<STX>w on page 49 Test Flash Memory Module ✓
<STX>X on page 50 Set Default Module ✓
<STX>x Delete File from Module —

<STX>Y Output Sensor Values —

<STX>y on page 50 Select Font Symbol Set ✓
<STX>Z on page 50 Print Internal Information and Dot Pattern ✓
<STX>z Pack Module —

Label-Formatting Commands

: on page 51 Set Cut By Amount ✓

Command Function Supported
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A on page 51 Set Format Attribute ✓
C on page 51 Set Column Offset Amount ✓
c on page 52 Set Cut By Amount ✓
D on page 52 Set Width and Height Dot Size ✓
E on page 52 Terminate Label Formatting Mode and Print Label ✓
G on page 52 Place Data in Global Register ✓
H on page 53 Enter Heat Setting ✓
M Select Mirror Mode —

m on page 53 Set Metric Mode ✓
n Set Inch Mode (Imperial) —

P on page 53 Set Print Speed ✓
p on page 53 Set Label Backup Speed ✓
Q on page 54 Set Quantity of Labels to Print ✓
R on page 54 Set Row Offset Amount ✓
r on page 54 Recall Stored Label Format ✓
S on page 54 Set Slew Rate ✓
s on page 55 Store Label Format in Module ✓
T on page 55 Set Field Data Line Terminator ✓
U Make Previous Field a String Replace Field —

W Wait Mode —

X on page 55 Terminate Label-Formatting Mode ✓
y on page 55 Select Font Symbol Set ✓
Z Zip Mode —

z on page 56 Zero (Ø) Conversion to "0" ✓
+ or > on page 56 Make Last Field Entered Increment Numeric (or 

Alphanumeric)
✓

- or < on page 57 Make Last Field Entered Decrement Numeric (or 
Alphanumeric)

✓

^ on page 57 Set Count By Amount ✓
<STX> S on page 58 Recall Global Data and Place in Field ✓
<STX> T on page 58 Print Time and Date ✓

Front-Loading Commands

<ESC>*c#D on page 59 Assign Font ID Number ✓
<ESC>)s#W on page 59 Font Descriptor ✓
<ESC>*c#E on page 59 Character Code ✓
<ESC>(s#W on page 60 Character Download Data ✓

Command Function Supported
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Control Codes

Control Codes are required for the printer to receive a command sequence. The code 
also specifies what type of command is being sent. Alternate control codes are 
available, which can be substituted for the standard control characters.

Table 1 shows the alternate control codes available.

Table 1 • Alternate Control Codes

Control Character Standard Main Frame

SOH 0x01 0x5E

STX 0x02 0x7E

CR 0x0D 0x0D

ESC 0x1B 0x1B

* “Count By” 0x5E 0x40

* Note: See label-formatting command ^ on page 57, Set Count By Amount.
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<SOH>#

Description  Reset the Printer

Syntax  <SOH>#

Purpose  Use this command to reset all settings to the last saved value and clears 
out the printer’s buffers.

<SOH>A

Description  Send ASCII Status String

Syntax  <SOH>A

Purpose  This command returns status information from the printer in a string of eight 
Y or N (true or false) characters:

<SOH>B

Description  Toggle Pause

Syntax  <SOH>B

Purpose  Use this command to pause and unpause the printer. When paused, 
printing pauses until the <SOH>B command or the <STX>p command is sent to the 
printer or until the user presses PAUSE on the printer’s control panel.

Byte Condition Indicated by Y

1 Interpreter busy (imaging)

2 Media out

3 Ribbon out

4 Printing batch

5 Busy printing

6 Printer paused

7 Label presented

8 N/A (always No)
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<SOH>C

Description  Stop/Cancel

Syntax  <SOH>C

Purpose  Use this command to cancel the batch of labels that is currently printing and 
pauses the printer.

<SOH>D

Description  SOH (Immediate Command) Shutdown

Syntax  <SOH>D

Purpose  Use this command to cause immediate commands (^A) to be ignored. This 
function is required before you load graphic images or fonts because some may 
contain data strings that would be misinterpreted as immediate commands. You can 
turn immediate commands back on by sending a valid SOH command three times, 
one second apart, or by resetting the printer.

<SOH>E

Description  Send Batch Quantity

Syntax  <SOH>E

Purpose  Use this command to tell the printer to return a 4-digit number that indicates 
the amount of labels that are remaining to print in the current batch.

<SOH>F

Description  Send Status Byte

Syntax  <SOH>F
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Purpose  Use this command to return status information from the printer as 1 or 0 
(true or false).

Bit Condition Indicated by 1

8 N/A (always 0)

7 Label presented

6 Printer paused

5 Busy printing

4 Printing batch

3 Ribbon out

2 Media out

1 Interpreter busy (imaging)
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System Level Commands

<STX>A

Description  Set Time and Date

Syntax  <STX>AwmdyhMJ

Range  
w = 1 digit indicating the day of the week (1 indicates Monday)
m = 2 digits indicating the month
d = 2 digits indicating the day
y = 4 digits indicating the year
h = 2 digits indicating the hour (24-hour format)
M = 2 digits indicating the minutes
J = 3 digits indicating the Julian date or a constant (when set to 000, the Julian date is 

calculated automatically. For other values, the number prints as a constant and will not 
increment each day.)

Purpose  Use this command to set the printer’s time and date.<STX>a

Description  Enable Feedback Characters

Syntax  <STX>a

Purpose  Use this command to enable status bytes to be returned from the printer 
after certain events.

• 07 = invalid character

• 1E = after each label is printed

• 1F = after a batch of labels is completed<STX>B

Description  Get Printer Time and Date Information

Syntax  <STX>B

Purpose  Use this command to recall the printer’s time and date in the following 
format: wmdyhMJ
where
w = 1 digit indicating the day of the week (1 indicates Monday)
m = 2 digits indicating the month
d = 2 digits indicating the day
y = 4 digits indicating the year
h = 2 digits indicating the hour (24-hour format)
M = 2 digits indicating the minutes
J = 3 digits indicating the Julian date or a constant (when set to 000, the Julian date is 

calculated automatically. For other values, the number prints as a constant and will not 
increment each day.)
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<STX>C

Description  Copy Module

Syntax  <STX>C

Purpose  Use this command to copy the data on Module B to Module A. 

<STX>c

Description  Set Continuous Paper Length

Syntax  <STX>ca

Range  
a = a four-digit number indicating the length of each label format

Purpose  Use this command to cause the printer to operate in continuous mode with 
the specified label length.<STX>E

Description  Set Print Quantity for Stored Label Format

Syntax  <STX>Ea

Range  
a = a four-digit number (include leading zeros, if necessary)

Notes  Use this command in conjunction with <STX>G on page 44 to specify the print 
quantity for the last stored label format and print the labels.

Example  
<STX>E0035
<STX>G

Prints 35 of the last label format.

<STX>e

Description  Select Transmissive (Edge) Sensor

Syntax  <STX>e

Supported  Based on testing, this command works the same on Zebra printers with 
the Virtual Device-D app as on the Prodigy Plus printer.

Purpose  Use this command to tell the printer to use the transmissive sensor to 
detect the gaps between labels.
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<STX>F

Description  Form Feed

Syntax  <STX>F

Purpose  Use this command to tell the printer to feed one label.

<STX>f

Description  Set Form Stop Position (Backfeed Command)

Syntax  <STX>fa

Range  
a = a three-digit number indicating the backfeed distance

Purpose  Use this command to set the backfeed distance. 

<STX>G

Description  Print Last Label Format

Syntax  <STX>G

Purpose  Use this command to print the last stored label format.

<STX>I

Description  Input Image Data

Syntax  <STX>Iabcd<CR>data

Range  
a = specify the memory module, A to E
b = the data type (optional); A = ASCII characters (0 to 9, A to F, 7 bit)
c = the image format

F = 7-bit image load file
B = 8-bit .BMP format, image flipped
b = 8-bit .BMP format, image saved as received
I = 8-bit .IMG format, image flipped
i = 8-bit .IMG format, image saved as received
P = 8-bit .PCX format, image flipped
p = 8-bit .PCX format, image saved as received

d = an image name, up to 16 characters and terminated by <CR>
data = the image data

Purpose  Use this command to download image data to the printer from the host.
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<STX>K

Description  Offset Distance, Top-of-Form

Syntax  <STX>K

Purpose  Use this command to adjust the label top position.

<STX>k

Description  Test RS-232 Port

Syntax  <STX>k

Purpose  Use this command to cause the printer to transmit a Y from the port from 
which the command was received. 

<STX>L

Description  Enter Label-Formatting Command Mode

Syntax  <STX>L

Purpose  Use this command to set the printer to the label-formatting command input 
mode, where you send it record structures and label-formatting commands (see 
Label-Formatting Commands on page 51). The printer ignores immediate commands, 
system-level commands, and font-loading commands while it is in label-formatting 
mode.

<STX>M

Description  Set Maximum Label Length

Syntax  <STX>Ma

Range  
a = a four-digit number indicating the maximum label length

Purpose  Use this command to tell the printer the maximum distance to find the 
label’s edge before determining a media error.
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<STX>m

Description  Set Printer to Metric

Syntax  <STX>m

Purpose  Use this command to tell the printer to measure metrically. The printer 
default is inches.

<STX>n

Description  Set Printer To Inches

Syntax  <STX>n

Purpose  Use this command to tell the printer to receive measurements in inches. 
<STX>O

Description  Set Start Print Position

Syntax  <STX>Oa

Range  
a = a four-digit number indicating the distance from the top of the label to the start print 

position

Purpose  Use this command to define the print start position.

<STX>o

Description  Cycle Cutter

Syntax  <STX>o

Purpose  Use this command to instantly cause the cutter to cut.

<STX>P

Description  Character (HEX) Dump Mode

Syntax  <STX>P

Purpose  Use this command to place the printer in Hex Dump Mode, where any data 
sent to the printer is printed in raw ASCII format. Reset the printer to exit this mode.
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<STX>p

Description  Controlled Pause

Syntax  <STX>p

Purpose  Use this command to pause the printer.

<STX>Q

Description  Clear All Modules

Syntax  <STX>QaCLEAR

Range  
a = specify the memory module, A to C

Purpose  Use this command to clear all Flash, RAM, and Internal Modules in the 
printer.

<STX>q

Description  Clear Module

Syntax  <STX>qa

Range  
a = the memory module, A to E

Purpose  Use this command to erase the selected memory module.

<STX>r

Description  Select Reflective Sensor

Syntax  <STX>r

Purpose  Use this command to tell the printer to look for a black mark between labels 
using the reflective sensor.
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<STX>S

Description  Set Feed Rate

Syntax  <STX>Sa

Range  
a = a letter from A to S

Purpose  Use this command to set the feed rate.

<STX>T

Description  Printhead Dot Pattern Test Label

Syntax  <STX>T

Purpose  Use this command to tell the printer to print a test label with dot patterns.

<STX>t

Description  Test RAM Memory Module

Syntax  <STX>t

Purpose  Use this command to test all RAM modules.

<STX>U

Description  Label Format Field Replacement

Syntax  <STX>Uab<CR>

Range  
a = a two-digit format field number
b = a new data string, which must be followed by <CR>

Purpose  Use this command to put new data into format fields.
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<STX>V

Description  Software Switch Settings

Syntax  <STX>Va

Range  
a = a one-digit ASCII value from 0 to F

Purpose  Use this command to allow multiple option settings to be modified without 
using the front panel menu.

<STX>v

Description  Printer's Firmware Version Information

Syntax  <STX>v

Purpose  Use this command to query the printer about its firmware. The printer 
responds with its current firmware version.

<STX>W

Description  Request Memory Module Information

Syntax  <STX>Wa

Range  
a = the data type

F = font
G = graphic
L = label

Purpose  Use this command to request a listing of all fonts, graphics, or formats on 
the printer’s memory modules.

<STX>w

Description  Test Flash Memory Module

Syntax  <STX>wa

Range  
a = the memory module, A or B

Purpose  Use this command to test all non-volatile memory modules. The printer 
responds with the module tested, the size of the module, and the test results.
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<STX>X

Description  Set Default Module

Syntax  <STX>Xa

Range  
a = the memory module, A to E

Purpose  Use this command to set the default memory module to which to download 
data. 

<STX>y

Description  Select Font Symbol Set

Syntax  <STX>yab

Range  
a = the byte size designation

S = single-byte symbol sets
U = double-byte symbol sets

b = the two-digit symbol set designation

Purpose  Use this command to specify the scalable font symbol set.

<STX>Z

Description  Print Internal Information and Dot Pattern

Syntax  <STX>Z

Purpose  Use this command to print a configuration label and a test label with dot 
patterns.
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:

Description  Set Cut By Amount

Syntax  :a

Range  
a = a four-digit number from 0001 to 9999, indicating how many labels to print before a 

cut

Purpose  Use this command to set the quantity of labels to be printed between cuts. 

A

Description  Set Format Attribute

Syntax  Aa

Range  
a = the attribute mode

1 = XOR mode (default). The areas where text strings, images, or barcodes 
intersect is not printed.

2 = Transparent mode. The areas where text strings, images, and barcodes 
intersect is printed, allowing fields to be printed on top of one another.

3 = Reserved.
4 = Reserved.

Purpose  Use this command to specify the type of format operation.

C

Description  Set Column Offset Amount

Syntax  Ca

Range  
a = a four-digit number for column offset amount. The default is 0000.

Purpose  Use this command to horizontally adjust where printing starts. 
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c

Description  Set Cut By Amount

Syntax  ca

Range  
a = a two-digit number from 01 to 99, indicating how many labels to print before a cut

Purpose  Use this command to set the quantity of labels to be printed between cuts. 
(Same function as : on page 51.)

D

Description  Set Width and Height Dot Size

Syntax  Dab

Range  
a = the dot width multiplier (1 or 2)
b = the dot height multiplier (1, 2, or 3)

Purpose  Use this command to change the minimum resolution of the printer by 
changing the size of each printed dot.

E

Description  Terminate Label Formatting Mode and Print Label

Syntax  E

Purpose  Use this command to force a label to print immediately based on the data it 
has received up to that point.

G

Description  Place Data in Global Register

Syntax  G

Purpose  Use this command to store the data from the last specified field so it can be 
recalled from another field.
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H

Description  Enter Heat Setting

Syntax  Ha

Range  
a = a two-digit number from 00 to 20

Purpose  Use this command to adjust the darkness relative to the front panel setting.

m

Description  Set Metric Mode

Syntax  m

Purpose  Use this command to set the printer to measure metrically.

P

Description  Set Print Speed

Syntax  Pa

Range  
a = a letter from A to P

Purpose  Use this command to set the rate at which the label advances while 
printing.

p

Description  Set Label Backup Speed

Syntax  pa

Range  
a = a letter from C to I

Purpose  Use this command to set the rate at which the label backfeeds.
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Q

Description  Set Quantity of Labels to Print

Syntax  Qa

Range  
a = a four-digit number from 0001 to 9999, indicating how many labels to print

Purpose  Use this command to set the quantity of labels to be printed.

R

Description  Set Row Offset Amount

Syntax  Ra

Range  
a = a four-digit number from 0001 to 9999, indicating the distance to offset

Purpose  Use this command to vertically adjust where printing starts.

r

Description  Recall Stored Label Format

Syntax  ra

Range  
a = a label name (up to 16 characters)

Purpose  Use this command to retrieve a label format that is stored on a memory 
module. 

S

Description  Set Slew Rate

Syntax  Sa

Range  
a = a letter from C to S

Purpose  Use this command to set the rate at which to feed blank labels.
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s

Description  Store Label Format in Module

Syntax  sab

Range  
a = the memory module, A to E
b = a label name (up to 16 characters)

Purpose  Use this command to store a label format on a specific module. 

T

Description  Set Field Data Line Terminator

Syntax  Ta

Range  
a = a two-character ASCII representation of a HEX code to be used for the end-of-data 

terminator

Purpose  Use this command to change the line terminator for the next format record, 
which allows you to use special binary control codes, such as carriage returns, into 
data to be printed.

X

Description  Terminate Label-Formatting Mode

Syntax  X

Purpose  Use this command to change to the system-command mode without 
printing a label. 

y

Description  Select Font Symbol Set

Syntax  yab

Range  
a = the byte size designation

S = single-byte symbol sets
U = double-byte symbol sets

b = the two-digit symbol set designation

Purpose  Use this command to specify the scalable font symbol set. (Same as 
<STX>y on page 50.)
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z

Description  Zero (Ø) Conversion to "0"

Syntax  z

Purpose  Use this command to eliminate slashes from zeros in fonts 0-8 and bar 
codes.

+ or >

Description  Make Last Field Entered Increment Numeric (or Alphanumeric)

Syntax  +ab or >ab

Range  
+ = numeric increment, > = alphanumeric increment
a = a fill character for leftmost characters in the incrementing field
b = the amount by which to increment the value

Purpose  Use this command to increment a value each time a label is printed.

Example  
<STX>L<CR> 
13220000000000054321<CR>
+03<CR>
Q0006<CR>
E<CR>

This example generates a label format with a single field that increments. The first 
value will be 54321, and the value will increment by 3 for the next five labels.
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- or <

Description  Make Last Field Entered Decrement Numeric (or Alphanumeric)

Syntax  -ab or <ab

Range  
- = numeric increment, < = alphanumeric increment
a = a fill character for leftmost characters in the incrementing field
b = the amount by which to increment the value

Purpose  Use this command to decrement a value each time a label is printed.

Example  
<STX>L<CR> 
132200000000000543BC<CR>
<03<CR>
Q0006<CR>
E<CR>

This example generates a label format with a single field that decrements. The 
first value will be 543BC, and the value will decrease by 3 for the next five labels.

^

Description  Set Count By Amount

Syntax  ^a

Range  
a = a two-digit number specifying the number of labels to be printed before 

incrementing/decrementing fields (default = 1)

Purpose  Use this command to print multiple labels with the same data while 
incrementing them sequentially as specified. 

Example  
<STX>L<CR> 
13220000000000054321<CR>
+01<CR>
^02<CR>
Q0008<CR>
E<CR>

This example prints two labels with the field value before incrementing the value 
by 1. A total of eight labels is printed with four of each value.
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<STX> S

Description  Recall Global Data and Place in Field

Syntax  <STX>Sa

Range  
a = a letter from A to P, specifying the global register containing the data to copy into the 

data field

Purpose  Use this command to indicate when the current field should use data 
previously stored by a G command (see G on page 52).

<STX> T

Description  Print Time and Date

Syntax  <STX>Ta<CR>

Range  
a = a set of characters indicating which parts of the real-time clock data to use

A = day of the week (Monday = 1)
BCD = day of week name
EF = month number
GH...O = month name
PQ = day of the month
RSTU = year
VW = hour in 24-hour format
XY = hour in 12-hour format
Za = minutes
gh = seconds
bc = AM or PM
def = Julian date

Purpose  Use this command to print the time and date using the real-time clock.

Example  
<STX>L<CR>
121100001000100<STX>TBCD GHI PQ, RSTU<CR>
E<CR>

Assuming that the current date is Thursday, May 14, 2014, the printed label 
shows:

THU MAY 14, 2014
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<ESC>*c#D

Description  Assign Font ID Number

Syntax  <ESC>*c#D

Range  
# = the three-digit font ID number from 100 to 999 (000 to 099 are reserved for resident 

printer fonts)

Purpose  Use this command to assign an ID number to the font that will be 
downloaded next.

<ESC>)s#W

Description  Font Descriptor

Syntax  <ESC>)s#Wa

Range  
# = from one to three ASCII digits, indicating the number of bytes of font descriptor data
a = the font descriptor

Purpose  Use this command to download general information for the current font. 

<ESC>*c#E

Description  Character Code

Syntax  <ESC>*c#E

Range  
# = from one to three ASCII digits, 0 to 999, indicating the value of the character

Purpose  Use this command to specify the ASCII decimal value of the character data 
that will be downloaded next.
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<ESC>(s#W

Description  Character Download Data

Syntax  <ESC>(s#Wa

Range  
# = from one to three ASCII digits, 0 to 999, indicating the number of bytes of bitmapped 

data
a = the bitmapped data

Purpose  Use this command to download all information for the previously specified 
character. 
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Set/Get/Do (SGD) Commands

The following SGD commands were added for use with your Virtual Device app. For 
more detailed information on SGD commands, see the Programming Guide for 
ZPL II®, ZBI 2, Set/Get/Do, Mirror, and WML (formerly the ZPL II Programming 
Guide).

apl.enable

Description  This command enables or disables a Virtual Device app.

Type  setvar

apl.framework_version

Description  For this Virtual Device, this command returns the firmware version.

Type  getvar

Note • 

• ZPL and CPCL may not function normally when a Virtual Device app is enabled. 
• You must restart the printer after changing the value of apl.enable.

Commands Details

setvar This command instructs the printer to enable a virtual device. 

Format: ! U1 setvar "apl.enable" "value" 
Values: 

"apl-d" = enable Virtual Device-D
"none" = disable any Virtual Device app (ZPL and CPCL function normally)

Example 1 • This example shows how to enable the Virtual Device-D app:

! U1 setvar "apl.enable" "apl-d"

Example 2 • This example shows how to disable the Virtual Device-D app:

! U1 setvar "apl.enable" "none"

Commands Details

getvar Format: ! U1 getvar "apl.framework_version" 
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Supported Fonts and
Barcodes
This section provides you with examples of the fonts and barcodes available on the 
Zebra printers with Virtual Device-D. 
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Table 2 • Supported Fonts

Font Example

0

1
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3

Table 2 • Supported Fonts (Continued)

Font Example
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Table 2 • Supported Fonts (Continued)

Font Example
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Table 2 • Supported Fonts (Continued)

Font Example
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Table 2 • Supported Fonts (Continued)

Font Example
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Table 2 • Supported Fonts (Continued)

Font Example
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Table 2 • Supported Fonts (Continued)

Font Example
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ZDownloader Utility
This section provides you with the instructions for downloading and installing the 
ZDownloader Utility.
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Downloading the ZDownloader Utility

To download the ZDownloader Utility, perform the following from your computer:

1. Open a web browser and navigate to www.zebra.com.

2. Click on the Support & Downloads header on the webpage.

3. Select a printer.

4. When the printer page opens, locate and select the Software Utilities tab.

Scroll down to the ZDownloader Utility and select the Download link. 

5. Click on the Accept and Begin Download Now button. 

The installation file download will begin.

Note • You will be prompted to create a user profile or login to www.zebra.com 
with an existing profile to download the ZDownloader Utility.
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www.zebra.com
www.zebra.com


79ZDownloader Utility
Installing the ZDownloader Utility
Installing the ZDownloader Utility
To install the ZDownloader Utility, perform the following from your computer:

1. Run the installation file after the download is complete.

2. If you are prompted to allow the application to make changes to your computer, 
click Yes.

The utility installs on your computer. When installation is complete, the Firmware 
Downloader and ZBI Key Manager installation wizard appears.

3. Click Next.

The End User License Agreement appears.
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4. Read the terms of the agreement.

5. Click the checkbox to accept the terms.

6. Click Next.

7. Click Next.

The installation wizard displays information about the installation.
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Installing the ZDownloader Utility
8. Click Next.

The installation wizard installs the application.

9. Click Finish to close the wizard.
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Index
Numerics
2-digit UPC Addendum, 73
5-digit UPC Addendum, 73

A
application installation

acquiring the app, 11
canceling a download in progress, 21
downloading the app to printers, 19

auto-detect printers, 13

B
backfeed distance, 44
backfeed speed, 53
barcode examples, 70
batch quantity, 40

C
change dot size, 52
character (HEX) dump mode, 46
character code, 59
clear all modules, 47
clear module, 47
Codabar, 72
Code 128, 71
Code 3 of 9, 70
Code 39 with modulo 43 checksum, 72
Code 93, 74
column offset, 51
connectivity options, 8
continuous paper length, 43

continuous paper length setting, 43
controlled pause, 47
copy module, 43
cutter

cycle cutter, 46
set 1 to 99 labels to print between cuts, 52
set 1 to 9999 labels to print between cuts, 51

cycle cutter, 46

D
darkness adjustment, 53
DataMatrix, 76
date and time

recall, 42
set, 42

decrement
count by amount, 57
set type and amount, 57

default module, 50
disabling the Virtual Device

by apl.enable SGD command, 61
through the control panel

QLn320 and QLn220 printers, 27
QLn420 printers, 24
ZT230, ZT400 series, ZT510, ZT600 se-

ries, ZD500 series, and ZD600
series printers, 30

ways to enable/disable, 23
download data

character, 60
dump mode

character, 46
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83Index
E
EAN-13, 71
EAN-8, 71
edge sensor, 43
enable feedback characters, 42
enabling the Virtual Device

by apl.enable SGD command, 61
through the control panel

QLn320 and QLn220 printers, 27
QLn420 printers, 24
ZT230, ZT400 series, ZT510, ZT600 se-

ries, ZD500 series, and ZD600
series printers, 30

ways to enable/disable, 23

F
features, 7
feed rate, 48
feedback characters, 42
field data line terminator, 55
field replacement, 48
FIM, 76
firmware

printer version, 49
flash memory module test, 49
font descriptor, 59
font examples, 63
font ID number, 59
font loading commands

assign font ID number, 59
character code, 59
character download data, 60
font descriptor, 59

font symbol set selection, 50, 55
form feed, 44
form stop position, 44
format attributes, 51

G
global data recall, 58

H
HBIC, 72
heat setting, 53
Hex Dump Mode, 46
horizontal print adjustment, 51

I
immediate commands, 39
inches, 46

increment
count by amount, 57
set type and amount, 56

input image data, 44
Interleaved 2 of 5

example, 71
example with modulo 10 checksum, 72
example with modulo 10 checksum and 

shipping bearer bars, 73
internal information and dot pattern, 50
IP Ethernet printers

auto-detect, 13
manually add, 14

L
label format field replacement, 48
label formatting command input mode

entering, 45
exit and print label, 52
exit without printing label, 55

label top, 45
liability, 2

M
manually add printers, 14
maximum label length, 45
memory module identification, 49
metric, 46, 53
modifying printer communication settings 

through ZDownloader, 17
modules

clear all, 47
copy, 43
set default, 50
test flash memory module, 49

O
offset distance, 45
offset distance, top of form, 45
output sensor values, 50

P
paper length (continuous), 43
parallel printers, 14
pause

controlled, 47
toggle, 39

PDF-417, 76
Plessey, 72
Postnet, 74
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print darkness adjustment, 53
print internal information and dot pattern, 50
print last label format, 44
print position, 46
print quantity

for stored label format, 43
set number of labels to print, 54

print servers, 8
print speed, 53
printer resolution, changing dot size, 52
printhead dot pattern test label, 48

R
RAM memory module test, 48
recall global data, 58
recall stored label format, 54
recall time and date, 42
reflective sensor, 47
request memory module information, 49
reset the printer, 39
row offset, 54
RS-232 port test, 45

S
send ASCII status string, 39
send batch quantity, 40
send status byte, 40
serial interface

add printers, 14
set printer to inches, 46
set printer to metric, 46
Set/Get/Do (SGD) commands, 61
slew rate, 54
software switch settings, 49
SOH (Immediate Command) shutdown, 40
start print position, 46
stop/cancel batch of labels, 40
store data in global register, 52
store label format in specific module, 55
symbol set selection, 50

T
Telepen, 75
test flash memory module, 49
test RAM memory module, 48
test RS-232 port, 45

time and date
recall, 42
set, 42

toggle pause, 39
top of form, 45
TPCL mode supported commands, 35
transmissive (edge) sensor, 43
transparent mode, 51

U
UCC/EAN Code 128, 74
UCC/EAN Code 128 Random Weight, 75
UCC/EAN Code128 K-MART NON EDI, 75
UPC-A, 70
UPC-E, 70
UPS MaxiCode, Modes 2 and 3, 75
USB printers, 13

V
version

level of support for Virtual Devices, 61

W
wired print server

auto detect, 13
for more information, 8
manually add, 14

wireless print server
auto detect, 13
for more information, 8
manually add, 14

X
XOR mode, 51

Z
ZDownloader

adding printers, 12
canceling a download in progress, 21
deleting printers, 18
downloading the Virtual Device app to printers, 

19
downloading ZDownloader, 78
installing ZDownloader, 79
modifying printer settings, 17

zebra printer setup utility for android devices, 12
zero without slashes, 56
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